NEAX® 2400
CallCenter WorX-Enterprise IMX MAT
Quick Reference Guide

MAY, 2000
NEC America, Inc.
LIABILITY DISCLAIMER

NEC America, Inc. reserves the right to change the specifications, functions, or features, at any time, without notice.

NEC America, Inc. has prepared this document for the exclusive use of its employees and customers. The information contained herein is the property of NEC America, Inc. and shall not be reproduced without prior written approval from NEC America, Inc.

NEAX, and CallCenterWorX are registered trademarks of NEC Corporation.

© 2000 NEC America, Inc.
Printed in the USA

All other brand or product names are or may be trademarks or registered trademarks of, and are used to identify products or services of, their respective owners.

MS-DOS, Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation. Microsoft Windows 95 and Microsoft Windows 98 are trademarks of Microsoft Corporation.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Chapter 1 - About This Manual</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How This Guide is Organized</td>
<td>1</td>
</tr>
<tr>
<td>Using This Guide</td>
<td>1</td>
</tr>
<tr>
<td>General Conventions</td>
<td>2</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 2 - Getting Started</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>CallCenterWorX-Enterprise IMX MAT Overview</td>
<td>3</td>
</tr>
<tr>
<td>Requirements</td>
<td>4</td>
</tr>
<tr>
<td>Server Requirements</td>
<td>4</td>
</tr>
<tr>
<td>LAN Requirements</td>
<td>4</td>
</tr>
<tr>
<td>Communications Port Requirements</td>
<td>4</td>
</tr>
<tr>
<td>Installing CallCenterWorX-Enterprise IMX MAT</td>
<td>5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 3 - Using Online Help</th>
<th>13</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Help Features</td>
<td>13</td>
</tr>
<tr>
<td>Accessing the Online Help System</td>
<td>13</td>
</tr>
<tr>
<td>Navigating the Help System</td>
<td>14</td>
</tr>
<tr>
<td>Contents Tab</td>
<td>14</td>
</tr>
<tr>
<td>Index Tab</td>
<td>14</td>
</tr>
<tr>
<td>Search Tab</td>
<td>15</td>
</tr>
<tr>
<td>Glossary Tab</td>
<td>16</td>
</tr>
<tr>
<td>Printing Help Topics</td>
<td>17</td>
</tr>
<tr>
<td>Printing from the Contents, Index or Find Tabs</td>
<td>17</td>
</tr>
<tr>
<td>Tips</td>
<td>18</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 4 - IMX MAT Menu Commands</th>
<th>21</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Menu</td>
<td>21</td>
</tr>
<tr>
<td>View Menu</td>
<td>21</td>
</tr>
<tr>
<td>Options Menu</td>
<td>24</td>
</tr>
<tr>
<td>MAT Menu</td>
<td>25</td>
</tr>
<tr>
<td>Data Screen Buttons</td>
<td>26</td>
</tr>
<tr>
<td>How to Use the Buttons</td>
<td>26</td>
</tr>
<tr>
<td>Information Choices</td>
<td>27</td>
</tr>
<tr>
<td>Message Bars</td>
<td>27</td>
</tr>
<tr>
<td>Report Menu</td>
<td>27</td>
</tr>
<tr>
<td>Window Menu</td>
<td>31</td>
</tr>
<tr>
<td>Help Menu</td>
<td>31</td>
</tr>
</tbody>
</table>
This Page Left Blank.
# LIST OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-1</td>
<td>Welcome Dialog</td>
<td>5</td>
</tr>
<tr>
<td>2-2</td>
<td>Software License Agreement</td>
<td>6</td>
</tr>
<tr>
<td>2-3</td>
<td>Installation Information</td>
<td>7</td>
</tr>
<tr>
<td>2-4</td>
<td>User Information</td>
<td>8</td>
</tr>
<tr>
<td>2-5</td>
<td>Select Components</td>
<td>9</td>
</tr>
<tr>
<td>2-6</td>
<td>Select Program Folder</td>
<td>10</td>
</tr>
<tr>
<td>2-7</td>
<td>Copying Files</td>
<td>10</td>
</tr>
<tr>
<td>3-1</td>
<td>Help Topics Window</td>
<td>14</td>
</tr>
<tr>
<td>3-2</td>
<td>Help Topics Window - Index Tab</td>
<td>15</td>
</tr>
<tr>
<td>3-3</td>
<td>Help Topics Window - Search Tab</td>
<td>16</td>
</tr>
<tr>
<td>3-4</td>
<td>Help Topics Window - Glossary Tab</td>
<td>17</td>
</tr>
<tr>
<td>3-5</td>
<td>Print Dialog Box</td>
<td>18</td>
</tr>
<tr>
<td>4-1</td>
<td>IMX ACD MAT Console Screen</td>
<td>21</td>
</tr>
<tr>
<td>4-2</td>
<td>Console Screen</td>
<td>22</td>
</tr>
<tr>
<td>4-3</td>
<td>Toolbar Window</td>
<td>23</td>
</tr>
<tr>
<td>4-4</td>
<td>New Toolbar Window</td>
<td>23</td>
</tr>
<tr>
<td>4-5</td>
<td>Data Entry Screen Background Colors</td>
<td>24</td>
</tr>
<tr>
<td>4-6</td>
<td>MAT Menu</td>
<td>25</td>
</tr>
<tr>
<td>4-7</td>
<td>MAT Toolbar Icons</td>
<td>25</td>
</tr>
<tr>
<td>4-8</td>
<td>Sample Data Entry Screen</td>
<td>26</td>
</tr>
<tr>
<td>4-9</td>
<td>Report Menu</td>
<td>28</td>
</tr>
<tr>
<td>4-10</td>
<td>Sample Data Entry and Data Report Screens</td>
<td>29</td>
</tr>
<tr>
<td>4-11</td>
<td>Sample Report Print Preview Screen</td>
<td>30</td>
</tr>
</tbody>
</table>
Chapter 1   About This Manual

The CallCenterWorX-Enterprise IMX MAT Quick Reference Guide ("IMX ACD MAT") is designed to explain the basic capabilities of the CallCenterWorX-Enterprise IMX MAT application and the online Help system. All procedural information is located in the online Help system, not this Quick Reference Guide. If you need instructions for performing a procedure, which is not explained in this document, you should refer to the CallCenterWorX-Enterprise IMX MAT online Help system. Refer to Using Online Help in this manual for instructions on how to access CallCenterWorX-Enterprise IMX MAT online Help.

How This Guide is Organized

Chapter 1 - About This Manual
This chapter outlines how to use the manual, including the actual manual organization, and chapter layout.

Chapter 2 - Getting Started
This chapter outlines hardware requirements and installation procedures.

Chapter 3 - Using Online Help
This chapter describe the purpose and use of the CallCenterWorX-Enterprise IMX MAT online Help system.

Chapter 4 - IMX MAT Menu Commands
This chapter gives a detailed overview of the CallCenterWorX-Enterprise IMX MAT application and its functions and features, including screen format and menu descriptions.

Using This Guide

This guide is designed to make the application easy to understand and simple to use. In Chapter 2 - Getting Started, there are examples of the installation screens you will see in the CallCenterWorX-Enterprise IMX MAT application installation, with step-by-step instructions for the installation procedures you need to perform.

Note: The screens and procedures shown in this guide represent the typical installation of the CallCenterWorX-Enterprise IMX MAT. Remember that the CallCenterWorX-Enterprise IMX MAT application can be customized for each site, so the screens shown in this guide may not always reflect what appears on your installing PC.
General Conventions

This guide uses the following type conventions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Typeface or Convention</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Book titles</td>
<td>Italics</td>
<td><em>The CallCenterWorX-Enterprise IMX MAT</em></td>
</tr>
<tr>
<td>User input, variables</td>
<td>Boldface</td>
<td>Enter <strong>password</strong> at the prompt.</td>
</tr>
<tr>
<td>Menu names, Window titles, field names</td>
<td>Capitalized</td>
<td><strong>OPTIONS MENU, LINE STATUS WINDOW, USER ID FIELD</strong></td>
</tr>
<tr>
<td>Any screen output generated by the The CallCenterWorX-Enterprise IMX MAT application</td>
<td>Monospace</td>
<td>A message that appears in a popup window or the status area of the screen.</td>
</tr>
</tbody>
</table>

This guide uses the following conventions for menus and shortcuts:

<table>
<thead>
<tr>
<th>Example</th>
<th>Means</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Workstation</td>
<td>Choose the Workstation submenu on the File menu.</td>
</tr>
<tr>
<td>CTRL+N</td>
<td>Hold down the CTRL key while pressing the “n” key</td>
</tr>
<tr>
<td>CTRL+Shift+N</td>
<td>Hold down the CTRL key and the Shift key while pressing the “n” key</td>
</tr>
<tr>
<td>Click</td>
<td>Click the left mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click the right mouse button</td>
</tr>
</tbody>
</table>
Chapter 2  Getting Started

CallCenterWorX-Enterprise IMX MAT Overview

The NEAX 2400 IMX CallCenterWorX-Enterprise IMX MAT (maintenance administration terminal) application is a windows-based, user-friendly tool that can be used by any certified Call Center Manager, Supervisor, Administrator, or Technician. This application facilitates programming the database entities for both CallCenterWorX-Enterprise and Enterprise (I). This new Graphical User Interface (GUI) makes administering the ACD easy and simple. Adds, moves, and changes to the database can be done quickly and easily from any workstation running the application program.

The true benefit of this tool is that any Call Center Supervisor can login to the PBX from any Windows workstation on the LAN/WAN and administer the ACD database with an easy-to-use, user-friendly graphical interface. An online Help system is also available with this tool to help navigate through the application.

The CallCenterWorX-Enterprise IMX MAT application can reside on any Windows 95, 98, 2000, or NT workstation and will permit the administrators to connect remotely to the ACD engine via the LAN and assign or modify the way the ACD and its entities (agents, splits, login IDs, call control vectors, etc.) are programmed. The CallCenterWorX-Enterprise IMX MAT Commands can be loaded onto any windows workstation on the network. When the CallCenterWorX-Enterprise IMX MAT application is running, it attaches to the IMX MAT program which must also be installed and running on the same workstation. Both applications connect to the switch via a TCP/IP LAN/WAN or serial RS-232 connection. Once connection is established to the PBX, changes to the database can be performed quickly by the Call Center administrator. For security purposes, a password and login ID may be required at each workstation gaining access to the database.

The user interface provides the administrator with a toolbar of icons that permit access to each area of the ACD. The user simply points to the appropriate icon, and clicks on it to go into a certain programming entity. Pilot numbers, splits, login IDs, and call control vectors are among other things that can be accessed and changed from this user interface.
Requirements

In order for the IMX ACD MAT application to operate properly, your operating environment must meet the following requirements.

Server Requirements

Minimum Configuration
- Microsoft® Windows 95, 98, 2000, or NT® Workstation 4.0 operating system
- Pentium 166 MHz processor
- 64 MB RAM
- 100 MB free hard drive space
- 800X600 monitor resolution
- CD-ROM drive (any OS supported device)
- Modem (any OS supported device; required when IMX MAT is used for remote dialup access).

LAN Requirements

Any 10 BASE-T Network Interface Card when IMX MAT is connected across TCP/IP.

Communications Port Requirements

COM1-COM4 when IMX MAT is connected across serial RS-232C port.

Note: The IMX MAT Commands must also be installed at the same workstation as the CallCenterWorX-Enterprise IMX MAT Commands. CallCenterWorX-Enterprise IMX MAT command will not work without the IMX MAT commands.
Installing CallCenterWorX-Enterprise IMX MAT

The following procedures guide you through the installation of CallCenterWorX-Enterprise IMX MAT application. The Setup program consists of a series of dialog boxes that supply default answers to questions regarding the installation of files to your hard disk.

**Important:** *Be sure to close all Windows programs before beginning the application installation.*

1. Insert the CallCenterWorX-Enterprise IMX MAT installation CD into the CD-ROM drive to begin the Setup program. The autorun feature of CallCenterWorX-Enterprise IMX MAT application displays the introduction window, followed by the Welcome dialog (Figure 2-1).

**Figure 2-1  Welcome Dialog**
2. Click **Next**. The Software License Agreement dialog box displays (**Figure 2-2**).

![Software License Agreement](image)

**Figure 2-2  Software License Agreement**

3. Read the software license agreement in the list box and click **Yes** to accept the terms of the agreement and to continue with the installation.

4. The Installation Information screen displays (**Figure 2-3**). Click **Next** to continue.
5. The User Information screen is displayed next (Figure 2-4). Verify the information appearing in each field or enter in information where the fields are left blank. Click Next.
6. The Select Components screen displays (Figure 2-5). Those components with a checkmark to the left will be installed. If there are certain components you do not want installed, simply click in the checkbox to deselect that component. Click **Next** to continue.
Figure 2-5 Select Components

7. The Select Program Folder screen displays (Figure 2-6). You may select a folder name from the existing folder list, or type a new name in the box. To accept the Program Folder shown in the dialog box, click **Next**.
8. Next, the progress of install file copying and the overall installation is shown on the graphics indicators.
9. When all files have been copied and installed, you will be returned to your windows environment.

This completes the setup and installation for the CallCenterWorX-Enterprise IMX MAT application.
## Chapter 3  Using Online Help

### Online Help Features

The CallCenterWorX-Enterprise IMX MAT online Help system features include:

- Context-sensitive Help for every dialog, button, and field within the program.
- Step-by-step procedures assigning, displaying, updating, printing, and removing CallCenterWorX-Enterprise IMX MAT data.
- Comprehensive glossary in each program.
- ACD functionality with respect to supported commands.

### Accessing the Online Help System

There are several ways to use the online Help system within CallCenterWorX-Enterprise IMX MAT. You can display and work in the current dialog while a Help window is open. You can also resize, move, tile, or cascade the online Help window to make it easier to display and follow the Help procedures while working in the CallCenterWorX-Enterprise IMX MAT application.

To access Help from within the CallCenterWorX-Enterprise IMX MAT application, do one of the following:

- Select **Help Topic** from the **Help Menu**.
- Press **F1** to display Help for the current CallCenterWorX-Enterprise IMX MAT dialog.
- Click on the **Help button** for help on a topic. Click the **What’s This Help button** for context-sensitive help.
Navigating the Help System

CallCenterWorX-Enterprise IMX MAT Online Help is deployed using the Microsoft HTML Help format. The help system will be viewed in a tri-pane window.

- The left pane contains the Contents, Index, Search and Glossary tabs to help users move around the system.
- The right pane contains the selected help topic.
- The top pane has navigational buttons to help the users move through the help system.

![Figure 3-1 Help Topics Window](image)

Contents Tab

The Contents tab (Figure 3-1) is intended to be used as an online Table of Contents.

- Double-clicking a Closed Book Bullet displays all the help topics contained within the book.
- Double-clicking an Open Book Bullet closes the book and all of its help topics.
- Double-clicking a Help Topic Bullet displays the Help topic window for that bullet

Index Tab

The Index tab (Figure 3-2) displays a multi-level list of topics and keywords or phrases.
Call Center WorX-Enterprise IMX MAT Quick Reference Guide

Using Online Help

Figure 3-2 Help Topics Window - Index Tab

Search Tab

The Search tab (Figure 3-3 ) provides another quick way to find information. Simply type a keyword or phrase and a list of all topics where the keyword or phrase is found will be displayed. Click on a topic to go directly to that topic.
Glossary Tab

The Glossary tab (Figure 3-4) provides a list of terms and definitions related to the subject matter in the help system.
Printing Help Topics

CallCenterWorX-Enterprise IMX MAT Online Help is not available in hard copy, but you can print topics of interest to you from several places within the Help system. The following procedure explains the process of printing Help topics.

Printing from the Contents, Index or Find Tabs

1. Highlight the Help topic you wish to print.
2. Click the Print icon at the top of the window. The Print dialog box displays (Figure 3-5 ).
3. Choose one of the following in the Print Setup:
   - To print to a printer, click on the **Name** drop down box and select a printer.
   - To print to a file, click the **Print to file** check box.

4. In your Print command, click the **All** radio button to print the entire report.

5. Use the **up** and/or **down arrows** in the **Number of copies** field, or double-click in the field and enter a value.

6. (Optional) Click the **Collate** check box in the Copies box.

7. (Optional) Click the **Print all linked documents** checkbox to print all topics that are linked to the current topic. or click the **Print table of links** to print a listing of the topics that are liked to the current topic.

8. Click **OK**.

**Tips**

- Use the right mouse button to click inside the Help window, then click **Print Topic**. This also works for printing the contents of a pop-up window.
• Print a group of related topics by clicking a book in the Help Contents and then clicking the **Print** button.
This Page Left Blank.
Chapter 4  IMX MAT Menu Commands

Figure 4-1  IMX ACD MAT Console Screen

The CallCenterWorX-Enterprise IMX MAT console window is the main window of the application and is used for all of the administrative functions. The menus on the CallCenterWorX-Enterprise IMX MAT window are described in the following sections.

**File Menu**
The File menu contains the Exit command, which provides an orderly exit from the program.

**View Menu**
The View Menu controls the behavior of the Toolbars, the Workbook area, and the Status Bar on the console screen.
The Toolbar areas shown above, are the MAT command toolbar, the Reports toolbar, and the Personal toolbar.

- The MAT toolbar icons provide one of the three ways to access MAT commands.
- Reports can be generated by use of the Report toolbar icons as well as from the Data Entry screen List button.
- The Personal toolbar can be named to suit your purpose and can include any icons you wish to use.
Selecting the **Toolbars** option under the **View menu** displays the check list of available toolbars.

![Figure 4-3 Toolbar Window](image)

**Figure 4-3 Toolbar Window**

**Toolbars Options**

- Toolbars can be displayed (checked) or hidden (unchecked).
- A toolbar can be relocated to any portion of the screen, including the Workbook area.
- The **Reset** button will restore the default condition to the toolbars.

**Personal Toolbars**

- Personal toolbars can be created for specific purposes or for convenience in frequent usage. Using the **New...** button in the main Toolbars dialog box to display the New Toolbar window, you can type in a custom name for the new toolbar.

![Figure 4-4 New Toolbar Window](image)

**Figure 4-4 New Toolbar Window**

- You can drag individual icons to the new toolbar to construct a personalized selection in any order.
**Note:** If you move an icon onto a personal toolbar which you later deactivate, and the icon is then missing from its original (source) toolbar, re-selecting the original toolbar in the main Toolbars dialog box and pressing the Reset button will restore the icon.

The **Workbook** area of the console screen shows a tab for each screen as it is opened, allowing rapid selection when multiple screens are displayed.

- The tab shows the icon of the command with the name of the command.
- The Workbook area can be removed to increase space on the main screen by clicking the checked option under the **View menu**. This toggles to an unchecked option which removes the Workbook until you check it again.

The **Status Bar** on the console screen indicates the current condition of the system.

- The “Ready” on the left side indicates that the system is connected and ready for the input of commands or data.
- The **Status Bar** area can be removed by clicking the checked option under the **View menu**. This toggles to an unchecked option and converts the Status Bar area to screen area. Clicking on the unchecked Status Bar option restores the Status Bar to the screen.

**Options Menu**

- The **Workbook / Toggle Icons** option allows the choice of showing or not showing the command icon on the Workbook tab at the bottom of the screen.
- The **Redraw** choice provides the options of **Normal** or **Optimized** for refreshing the screen.
- **Background** offers a choice of colors and textures for the Data Entry screens. The next screen opened after making a color selection will show that background color while the screen is open.

![Figure 4-5 Data Entry Screen Background Colors](image)
MAT Menu

Menu Commands

The commands used for the Maintenance Administration Terminal (MAT) functions are listed in this menu. MAT functions can be activated in one of 3 ways:

1. Select a command from the **MAT menu** (such as selecting the **Tenant Data** command by clicking **Tenant Data** under the **MAT menu**).

2. Select a command from the **keyboard** by holding down the **Control and Shift keys** and pressing an alphabetic letter (such as selecting the **Tenant Data** command by holding down **CTRL** and **SHIFT** and pressing **T**). For a complete list of MAT menu and keyboard commands.

3. Select a command from the **MAT icon Toolbar** located under the menu bar by using the mouse (such as selecting the **Tenant Data toolbar icon**).

Figure 4-6 MAT Menu

Figure 4-7 MAT Toolbar Icons

Each data entry screen displays its icon in the top left corner, and the icon also appears on the screen’s tab in the Workbook area.
Figure 4-8 Sample Data Entry Screen

Data Screen Buttons

- The top Update/Remove button reflects the status of the contents. The “Update” button will initially be shown with the first configuration of data. Press the Update button (or the keyboard Enter key) to save an entry or a change. Any data entry or change after the first entry will cause the top button to show “Remove.” You can press the top button (now the Remove button) to remove a previous entry.

- The center List button opens a Report screen view of the current data configured for this command. That screen displays icons allowing you to Save to a file, Print, Print Preview, or Change font style or size directly from the Report view.

- The bottom Close button closes the data screen without saving any changes if the top button (Update/Remove) has not been pressed previously. Pressing the keyboard Escape key also closes the screen without saving entries or changes if Update/Remove has not been pressed previously.

How to Use the Buttons

(a) To save newly entered or changed information, press Update or the Enter key.

(b) To delete information, press Remove.

(c) To close without saving changes, press Close instead of Update, or press the Escape key.

(d) To close after saving changes by pressing Update or Enter, press Close.
Information Choices

The choices shown in the drop-down boxes in the data dialog sometimes include only the information previously entered. For example, if only Split 1 and Split 2 have been entered and saved, those will be the only options shown, even though the Tenant Data may have been configured to allow more than 2 splits.

In order to access an additional option, it must first be entered as new information and the Update button (or Enter key) pressed. It will then become another choice.

Attempted entry of out-of-range information (such as more splits than a tenant has been configured for) will generate a red error message on the Operation Result Message Bar of the Data Entry Screen.

Message Bars

The Form Status Message Bar, located in the bottom left area of the Data Entry Screen, reflects the current state of information entry in the form.

<table>
<thead>
<tr>
<th>State</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>An entry exists which is unchanged this session</td>
<td>Remove Entry?</td>
</tr>
<tr>
<td>A change has been made to an existing entry</td>
<td>Update name of entity (such as Split)</td>
</tr>
<tr>
<td>An entry is made that does not yet exist in the ACD</td>
<td>New name of entity</td>
</tr>
</tbody>
</table>

The Operation Result Message Bar, located in the bottom right area of the Data Entry Screen reflects the result of the current entry in the form.

<table>
<thead>
<tr>
<th>State</th>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>Correct entry of an item (within character and digit limits, within configuration limits)</td>
<td>ACD Data written successfully (in green)</td>
</tr>
<tr>
<td>Attempted entry of an item which already exists in another entity</td>
<td>Entry exists in another name of entity (in red)</td>
</tr>
</tbody>
</table>

Report Menu

The first options available on the Report Menu are:

- **Save to Text File**, which saves the data to the text file name you specify.
- **Print Report**, which outputs a report to a designated printer without opening the Data Entry screen.
- **Print Preview**, which displays a sample of the report as it will be printed.
Additionally, you can change the report text and header font by selecting the font style and size. These options are also available as icons on the menu bar of the Data Report screen (which is created by pressing the List button on the Data Entry screen).

Figure 4-9 Report Menu

Opening a Report screen for a particular MAT command name can be done in any of four ways:

1. Select a MAT command name from the listing of report titles under the Report menu.
2. Hold down the ALT and Shift keys and enter the letter specified in the Report menu listing for that command.
3. Press the List button on the Data Entry screen for that command.
4. Select the icon for that command from the Reports Toolbar.
The icons on the Data Report Screen shown above offer quick ways to:

- Save the data to a text file.
- Change the font style and size used in the report.
- View a Print Preview of the report.
- Send the report to a printer.

Data Reports which are too wide for the whole report to fit on the screen will appear with a horizontal scroll bar across the bottom, allowing you to move across the columns. You can also adjust the viewing position of a report by selecting the title bar with the mouse and dragging the report to bring the desired columns into view.

The columns in a Data Report screen can be resized or rearranged by using the mouse to drag the column headings.
The **Print Preview screen** can be opened by choosing the **Print Preview command** on the Report menu, or by clicking the **Print Preview icon** on the Data Report menu bar.

- The **Print** command sends the report to the printer.
- The **Next Page, Previous Page, Two Page, Zoom In, and Zoom Out** commands on the Print Preview menu bar allow you to have varying views of the displayed report.
- The **Close** command closes the Print Preview screen.
- The column arrangement will reflect any column adjustments made in the Data Report screen.
Window Menu

Cascade
- Places all open dialogs on top of each other in a cascading fashion, with each title bar visible and selectable.

Tile
- Places all open dialogs apart from each other with some overlap between dialogs, with each item selectable.

Close All
- Closes all open screens.

Help Menu
- **Help Topic** opens the IMX ACD MAT online Help system.
- **About** provides information about the IMX ACD MAT system including version and build number.
This Page Left Blank.